Content

1 Conversion Guide for SAP S/4HANA. .................................................. 4

2 Getting Started. ................................................................................. 5
2.1 Documentation and SAP Notes for the Conversion. .......................... 5
2.2 Overview of the Conversion Process. .................................................. 7
2.3 Conversion in a Distributed System Landscape. ................................. 11
2.4 SAP Readiness Check Versus SI-Check. ............................................. 12

3 Preparing the Conversion. ................................................................. 14
3.1 System Requirements. .................................................................. 15
3.2 What’s the Impact on Your System Landscape? ................................. 16
3.3 Supported Start Releases. .................................................................. 17
3.4 Data Volume Reduction. ................................................................ 17
3.5 Maintenance Planner. ..................................................................... 18
3.6 Simplification Item-Check. .............................................................. 19
3.7 Custom Code Analysis. .................................................................. 22
3.8 Cross-Application Preparations. .................................................... 22
  Prepare the Use of the Maintenance Planner. .................................... 23
  Remove Client 066. ......................................................................... 24
  Uninstall SAP Fiori Apps. ................................................................. 24
  Prepare the Conversion of Authorizations. ......................................... 25
  Prepare the Conversion for SAP Fiori UX Enablement. ....................... 25
3.9 List of Application-Specific Preparations. ......................................... 25

4 Realizing the Conversion. ............................................................... 27
4.1 Conversion Using SUM. ................................................................. 27
4.2 Custom Code Adaptation. ............................................................... 28
4.3 Cross-Application Follow-On Activities. ......................................... 28
  Adapting Database Extensions to SAP S/4HANA. ............................... 29
  Output Management. .............................................................. 29
  Follow-On Activities for the Conversion of Authorizations. ................. 32
  Follow-On Activities for SAP Fiori UX Enablement (incl. Authorizations). 33
  Adapting the User Interface. ............................................................. 35
4.4 List of Application-Specific Follow-On Activities. ............................. 35
## Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>September 15, 2017</td>
<td>First published version.</td>
</tr>
</tbody>
</table>
| 1.0     | October 16, 2017  | Updated references to SUM to the correct version: SUM 2.0.  
Documented and SAP Notes for the Conversion [page 5]: Added SAP Notes 2399707 and 2502552.  
Overview of the Conversion Process [page 7]: Updated Step 5 Simplification Item-Check.  
SAP Readiness Check Versus SI-Check [page 12]: Added SAP Note 2290622.  
Simplification Item-Check [page 19]: Minor changes.  
Minor changes overall. |
1 Conversion Guide for SAP S/4HANA

SAP S/4HANA is the next-generation business suite. It is fully built on the most advanced in-memory platform existing today: SAP HANA. The product uses modern design principles with the SAP Fiori user experience (UX) as well as a new role-based user experience concept. With the move to SAP S/4HANA, you are benefitting from continuous application innovations such as:

- Application optimizations specific for SAP HANA in-memory platform
  With SAP S/4HANA, SAP optimizes the application to make best use of the capabilities of the SAP HANA database. For example, we removed aggregates, and reduced the data footprint.
- Responsive user experience design
  With SAP S/4HANA, SAP designs the application with the latest role-based user experience (UX).
- Unifying functionality in the core
  With SAP S/4HANA, SAP removes redundancy by providing one functionality for one objective.

With SAP S/4HANA, SAP helps businesses to run simple in the digital economy, including such topics and principles as the Internet of Things, Big Data, business networks, and mobile-first.

This guide explain the conversion process with which you can move from your existing SAP Business Suite to the next-generation business suite: SAP S/4HANA.
2 Getting Started

Read this guide carefully to get an overview of how to convert an existing SAP Business Suite system to SAP S/4HANA 1709.

This guide has to be used together with the following documents:

- Simplification List for SAP S/4HANA 1709
- System Conversion to SAP S/4HANA using SUM 2.0 SP <latest version> (incl. DMO)
- Maintenance Planner User Guide

You find more information about these documents and guides (including where to find them), as well as additional important documents and SAP Notes relevant for the conversion in the section Documentation and SAP Notes for the Conversion [page 5].

The section Overview of the Conversion Process [page 7] provides information about the different phases of the conversion and the tools involved.

The section Preparing the Conversion [page 14] and Realizing the Conversion [page 27] provide details for those conversion phases.

2.1 Documentation and SAP Notes for the Conversion

Required Documents and SAP Notes

You require at least the following documents and SAP Notes.

Table 2:

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simplification List for SAP S/4HANA</td>
<td>SAP Note 2313884</td>
<td>Contains additional important information about simplifications.</td>
</tr>
<tr>
<td>System Conversion to SAP S/4HANA using SUM 2.0 SP &lt;latest version&gt; (incl. DMO)</td>
<td><a href="https://support.sap.com/sltoolset">https://support.sap.com/sltoolset</a></td>
<td>Describes how to prepare the system for running the Software Update Manager, how to use it, and what general follow-up steps are required.</td>
</tr>
<tr>
<td>Document</td>
<td>Available at</td>
<td>Comment</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP S/4HANA 1709: Release Information Note</td>
<td>SAP Note <a href="https://support.sap.com">2482453</a></td>
<td></td>
</tr>
<tr>
<td>SAP S/4HANA: Restriction Note</td>
<td>SAP Note <a href="https://support.sap.com">2491467</a></td>
<td></td>
</tr>
<tr>
<td>SAP FIORI for SAP S/4HANA: Release Information Note</td>
<td><a href="https://support.sap.com">2482461</a></td>
<td></td>
</tr>
<tr>
<td>SAP S/4HANA Add-on Note</td>
<td>SAP Note <a href="https://support.sap.com">2214409</a></td>
<td></td>
</tr>
<tr>
<td>Delivery of the S/4H Simplification Item-Check</td>
<td>SAP Notes <a href="https://support.sap.com">2399707</a> and <a href="https://support.sap.com">2502552</a></td>
<td>With this note, the SAP S/4HANA Pre-Transition Check Report is delivered.</td>
</tr>
<tr>
<td>SAP S/4HANA 1709 - application specific notes in system conversion / upgrade preparation phase</td>
<td>SAP Note <a href="https://support.sap.com">2495992</a></td>
<td>Information about errors that may occur during the preparation phase of the conversion.</td>
</tr>
<tr>
<td>Additional information on converting to SAP S/4HANA using SUM 2.0 &lt;latest version&gt;</td>
<td>SAP Note for the latest version of SUM 2.0 at <a href="https://support.sap.com/sitoolset">https://support.sap.com/sitoolset</a> System Maintenance</td>
<td>Information about errors that may occur during the SUM phase of the conversion.</td>
</tr>
<tr>
<td>SAP S/4HANA 1709 - application specific notes in system conversion / upgrade follow-on phase</td>
<td>SAP Note <a href="https://support.sap.com">2495932</a></td>
<td>Information about errors that may occur during the follow-on phase of the conversion.</td>
</tr>
</tbody>
</table>

### Additional Information and SAP Notes

The following table lists important additional documents and SAP Notes.
Table 3:

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Conversion to SAP S/4HANA</td>
<td>System Conversion to SAP S/4HANA <a href="#"></a></td>
<td>Information about the system conversion on SCN.</td>
</tr>
<tr>
<td>SAP S/4HANA: Always-Off Business Functions</td>
<td>SAP Note <a href="#">2240359</a></td>
<td></td>
</tr>
<tr>
<td>SAP S/4HANA: Always-On Business Functions</td>
<td>SAP Note <a href="#">2240360</a></td>
<td></td>
</tr>
<tr>
<td>Uninstalling ABAP Add-ons</td>
<td>SAP Note <a href="#">2011192</a></td>
<td></td>
</tr>
<tr>
<td>Data Migration of Financials in SAP S/4HANA: Do not migrate twice!</td>
<td>SAP Note <a href="#">2294488</a></td>
<td>Relevant if you are planning to convert a SAP Simple Finance, respectively SAP S/4HANA Finance, on-premise edition installation to SAP S/4HANA.</td>
</tr>
<tr>
<td>Conversion of Financial Accounting to SAP S/4HANA</td>
<td>SAP Note <a href="#">2332030</a></td>
<td></td>
</tr>
<tr>
<td>S4TWL: Business partner data exchange between SAP CRM and SAP S/4HANA – required pre-conversion and post-conversion actions</td>
<td>SAP Note <a href="#">2285062</a></td>
<td></td>
</tr>
</tbody>
</table>

### 2.2 Overview of the Conversion Process

SAP provides a process for the conversion to SAP S/4HANA. The following figure gives an overview of the tools, the phases, and the activities involved in the process.

**Recommendation**

We recommend that you do the activities in the sequence shown in the figure and explained in the sections below.
Prepare Phase

Simplification List

To enable you to do an optimal planning of your path to SAP S/4HANA, we provide the Simplification List for SAP S/4HANA 1709. The Simplification List is the complete collection of simplification items presented by application or functional area. Each simplification item details the steps that need to be taken for the conversion from a business and a technical point of view, both preparatory and follow-on steps and each item is available as a SAP Note that may contain additional information.

**Recommendation**

We recommend that you consume the Simplification List via the SAP Readiness Check for SAP S/4HANA. Based on an analysis of the configuration, data, and usage of your productive SAP Enterprise Resource Planning system, the SAP Readiness Check for SAP S/4HANA identifies the simplification items relevant for your conversion.

For more information about how to use the SAP Readiness Check for SAP S/4HANA, see [https://help.sap.com/viewer/p/SAP_READINESS_CHECK](https://help.sap.com/viewer/p/SAP_READINESS_CHECK).

You find the Simplification List at [http://help.sap.com/s4hana_op_1709](http://help.sap.com/s4hana_op_1709). See also SAP Note 2313884, to which the Simplification List is also attached (as both an Excel list and as a PDF that contains the text of the simplification item SAP Notes).

**Note**

When using the Simplification List PDF directly instead of the SAP Readiness Check for SAP S/4HANA, please note that the PDF contains all the simplification items, not only those that are relevant for your conversion project. This means you need to identify those which are actually relevant for your system conversion (which the SAP Readiness Check for SAP S/4HANA does automatically). And when you have done this, you also need to look at the relevant simplification SAP Notes themselves to get all the available information. The SAP Notes...
may contain more information than the Simplification List PDF, because they may have attachments and may reference other SAP Notes. This situation is not reflected in the text of the Simplification List PDF, which is only an extract from the SAP Notes. The SAP Readiness Check for SAP S/4HANA links directly to the most recent version of the SAP Notes.

Please carefully read the description of all simplification items relevant for you (as determined either by the SAP Readiness Check for SAP S/4HANA or via the Simplification List), so that you understand the impact they might have on your system, business processes, or custom code and you find out which activities you might have to do in your conversion project.

**Recommendation**

We recommend that you do a test conversion in a dedicated system in a distributed system landscape [page 11] to get the results of the checks early on in your conversion project.

Before starting the realization phase of the conversion process, you also have to do the following preparatory activities:

1. **Planning**
   You need to gain an idea of the project steps and necessary preparations. Use the following tools to do your project planning:
   - Use the Roadmap Viewer to familiarize yourself with the project steps required for the transition to SAP S/4HANA.
     For more information, see [https://roadmapviewer-supportportal.dispatcher.hana.ondemand.com/](https://roadmapviewer-supportportal.dispatcher.hana.ondemand.com/).
   - SAP Readiness Check for SAP S/4HANA

   **Recommendation**

   We highly recommend to run the SAP Readiness Check for SAP S/4HANA in advance of your conversion project to identify any issues you need to consider and activities you need to do in preparation for your project.

   For more information about how to use the SAP Readiness Check for SAP S/4HANA, see [https://help.sap.com/viewer/p/SAP_READINESS_CHECK](https://help.sap.com/viewer/p/SAP_READINESS_CHECK).
   See also, [SAP Readiness Check Versus SI-Check](page 12).

2. **System Requirements**
   You need to be aware of system requirements, start releases, conversion paths, and data volume. See the following sections for more information:
   - System Requirements [page 15]
   - What's the Impact on Your System Landscape? [page 16]
   - Supported Start Releases [page 17]
   - Data Volume Reduction [page 17]

3. **Maintenance Planner**
   You need to run the maintenance planner tool as a first step in the conversion process. It checks your components, add-ons, and business functions to ensure compatibility with SAP S/4HANA and also creates the stack file used for the actual conversion process (done by the Software Update Manager tool). For more information, see [Maintenance Planner](page 18).
4. Simplification Item-Check
These checks identify important steps you need to take to make sure that your system can technically be converted and that your business processes can start running directly after the conversion process has been completed. For more information, see Simplification Item-Check [page 19].

5. Custom Code Migration
The custom code migration tool checks your custom code against a list of simplifications developed for SAP S/4HANA. For more information, see Custom Code Analysis [page 22] and Custom Code Adaptation [page 28].

6. Cross-application preparation activities
In addition to the general preparation steps described above, you also need to do some cross-application preparations. For more information, see Cross-Application Preparations [page 22].

7. Application-specific preparation activities
In addition to the cross-application preparations, you may also need to do some application-specific preparatory steps. These steps and their documentation are partly provided by the pre-checks and the custom code checks.
For a complete overview of all necessary steps, see the Simplification List (mentioned above). For an overview of some important preparations steps, see List of Application-Specific Preparations [page 25].
For more information about preparations for the conversion of Financial Accounting, see SAP Note 2332030.
Realize Phase

After you have done the steps of the prepare phase, you continue with the activities of the realize phase:

1. **Software Update Manager (SUM)**
   When you have completed the steps above, and have implemented all the adaptations required to ensure your system and your custom code is suited to SAP S/4HANA, you then run the SUM. The SUM does the database migration (if required), the actual software update, and the data conversion.
   For more information, see Realizing the Conversion [page 27].
   After the completion of the SUM run, we highly recommend that you adapt your custom code, see Custom Code Adaptation [page 28].

2. **Cross-application follow-on activities**
   Other manual cross-application activities may also be required. For more information, see Cross-Application Follow-On Activities [page 28].

3. **Application-specific follow-on activities**
   In addition to the cross-application follow-on activities, you may also need to do application-specific manual steps. These steps and their documentation are provided by the pre-checks and the custom code checks, which provide the list of simplification items relevant for your specific systems.
   For a complete overview of all necessary steps, see the Simplification List (mentioned above). For an overview of some important follow-on steps, see List of Application-Specific Follow-On Activities [page 35].
   For more information about the migration of Finance Data, see SAP Note 2332030.

2.3 Conversion in a Distributed System Landscape

When planning your conversion project, you should use a distributed system landscape as shown in the figure below. The figure is an example of a very simple version of a distributed system landscape comprising only development and productive systems to illustrate the principle.
The figure shows that there is a development system (DEV) used to apply updates and patches to the productive system (PROD), which, at the beginning of the conversion project (t1), is a SAP Business Suite system. You then set up a second development system (DEV 2) as a system copy of the original DEV system. You use the second development system to perform and test all phases of the conversion. You can collect all the necessary software changes during the test conversion in transport requests, including those that can only be done after a conversion (for example, the Finance customizing). Note that DEV t1 and DEV t2 as shown in the figure describe the same system, at points in time before (t1) and after (t2) the conversion. The collected transports with the required software changes are then handed over to the Software Update Manager (SUM) tool and applied during the real conversion of the productive system. Note that PROD t1 and PROD t2 as shown in the figure also describe the same productive system before (t1) and after (t2) the conversion.

The use of a distributed system landscape for your conversion allows you to take as long as needed to identify and process the software changes required by the conversion and then apply these changes efficiently during the conversion of your productive system to minimize downtime.

2.4 SAP Readiness Check Versus SI-Check

The tools SAP Readiness Check and Simplification Item-Check (SI-Check) are used to support the conversion process, see also Overview of the Conversion Process [page 7]. The following table explains the differences between the two tools.

For more information, see:
- SAP Note 2290622 (about the SAP Readiness Check).
- Simplification Item-Check [page 19]
<table>
<thead>
<tr>
<th></th>
<th>SAP Readiness Check</th>
<th>Simplification Item-Check /SDF/RC_START_CHECK</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Customer self-service provided by SAP Digital Business Services (included as standard support)</td>
<td>Standalone report</td>
</tr>
<tr>
<td><strong>SAP Solution Manager</strong></td>
<td>Required</td>
<td>Not required</td>
</tr>
<tr>
<td><strong>User Interface</strong></td>
<td>Cloud-based web interface</td>
<td>SAP GUI</td>
</tr>
</tbody>
</table>
| **Included Checks**  | ● Simplification item relevance  
● Custom code  
● Recommended SAP Fiori apps  
● Add-on compatibility  
● SAP Custom Development projects  
● SAP S/4HANA sizing  
● Business functions | ● Simplification item relevance  
● Check of system consistency before conversion or upgrade |
| **Called by Software Update Manager (SUM)** | No                                                                                  | Yes                                           |
| **Mandatory**        | No                                                                                   | Yes                                           |
| **Use Cases**        | Conversion to SAP S/4HANA                                                             | ● Conversion to SAP S/4HANA  
● Upgrade to a higher SAP S/4HANA release |
3 Preparing the Conversion

For the conversion to SAP S/4HANA you have to prepare an overall project plan and schedule the tasks. The preparation activities described in this section give you an idea of what is involved. For a short overview of the process, see Overview of the Conversion Process [page 7].

Note

In addition, review the planning section of the Software Update Manager guide System Conversion to SAP S/4HANA using SUM 2.0 <latest version> (incl. DMO) at https://support.sap.com/sitoolset ‣ Software Logistics Toolset (SL Toolset) ‣ System Maintenance.

Note

You find the cross-application preparation steps in this guide; you get the application-specific preparation steps with the Simplification Item-Check and custom-code checks and with the Simplification List for SAP S/4HANA 1709. Some of the most important application-specific preparation steps are also listed in this section: List of Application-Specific Preparations [page 25].

Please see also SAP Note 2495992.
3.1 System Requirements

Unicode

As a prerequisite for the conversion, your system needs to be a Unicode system. If your system is still non-Unicode, you can follow a two-step conversion approach: First, perform a combined upgrade and Unicode conversion with one of the supported start releases as target, then perform the conversion to SAP S/4HANA 1709.

For additional information, see Unicode Conversion Overview (on SAP SCN).

Application Server ABAP Only

Your system has to be an AS ABAP-only system. Dual-stack systems (AS ABAP and AS Java combined in one system) are not supported for the conversion. If your system is as dual-stack system, you have to split it before doing the conversion.

For additional information on how to perform a dual-stack split, see:
- SAP Note 1686144
- SAP Note 1655335
- Dual Stack Split

CDS Views (Core Data Services)

If you need to adapt your custom code during the conversion of your development system, you may need to create or edit CDS view. For example, to reflect your specific table appends in related CDS compatibility views. To find out whether these activities are required in your case, check the results of the corresponding Simplification Item-Checks and the S/4HANA-specific code inspector checks.

For additional information, see:
- Simplification Item-Check [page 19]
- Custom Code Migration [page 22]
- Configuring the ABAP Back-end for ABAP Development Tools
- CDS - Core Data Services (on SAP SCN)
- http://scn.sap.com/community/abap/eclipse
3.2 What's the Impact on Your System Landscape?

When you convert your system to SAP S/4HANA, you may have to adapt further systems or components in your system landscape.

SAP Enterprise Resource Planning (SAP ERP) Java Components

SAP ERP Java components are obsolete with SAP S/4HANA. You have to remove the technical Java system from the respective productive system in the Landscape Management Database (LMDB).

SAP NetWeaver

SAP NetWeaver 7.52 for SAP S/4HANA 1709

SAP S/4HANA 1709 requires SAP NetWeaver 7.52 for SAP S/4HANA 1709. For additional information about SAP NetWeaver 7.52 for SAP S/4HANA 1709, see:

- Information about the upgrade to SAP NetWeaver 7.52 for SAP S/4HANA 1709 in SAP Note 2350408
- Minimal database system platform requirements for SAP NetWeaver 7.52 in SAP Note 2329005

SAP NetWeaver AS for Java Instances

The following SAP NetWeaver AS for Java instances are relevant for SAP S/4HANA 1709:

- Adobe Document Services
- Enterprise Services Repository
- Advanced Adapter Engine Extended

These instances need to run on SAP NetWeaver 7.3 EHP1 (or higher).

Enterprise Services Repository (ESR) Content: You have to apply the ESR content XI CONTENT S4CORE 101.

SAP Fiori Front-End Server

SAP S/4HANA 1709 requires SAP NetWeaver 7.52 as front-end server.

You can use an existing front-end server (hub) for the SAP Fiori for SAP S/4HANA 1709 installation. Existing apps continue to run against the old back-end systems while the newly installed applications of SAP Fiori for S/4HANA 1709 need to be configured to run against the SAP S/4HANA 1709 system. As a prerequisite, you have to migrate the database of the central hub system (supported databases are SAP HANA, SAP MaxDB, or SAP ASE) and upgrade the system.

You can also run the SAP Fiori server as an add-on to the SAP S/4HANA 1709 server.

For additional information about installing the SAP Fiori server, see the SAP Help Portal at https://help.sap.com/fiori_implementation.

### 3.3 Supported Start Releases

For a one-step conversion, your system needs to have a minimum release level. The following start releases are supported:

- SAP ERP 6.0, EHP 0-8
- SAP Business Suite powered by SAP HANA
- SAP Simple Finance Add-On 1.0 for SAP Business Suite powered by SAP HANA
- SAP Simple Finance, on-premise edition 1503
- SAP S/4HANA Finance 1605

Not all start releases may initially be supported, see SAP Note 2277083 for more information. Also check the SAP S/4HANA 1709: Release Information Note 2482453 for the required feature package stack equivalencies.

### 3.4 Data Volume Reduction

SAP Data Volume Management is designed to reduce the data footprint so that you can achieve a shorter conversion duration due to reduced load size. Data Volume Management (DVM) offers various capabilities supporting the pre- and post-conversion phases. One central tool is the SAP DVM Work Center (DVM WoC) in SAP Solution Manager, including tools with a special focus on SAP HANA.

- **Guided Self Service:** You can generate a best practice document to determine data that can be reduced most efficiently in an SAP system before the conversion. You can use the same tool after the conversion to develop a blueprint for a DVM strategy.
- **Reorganization and Compression:** You can use this tool without a SAP HANA context in order to simulate the savings gained by reorganizing tables or databases or compressing the database.
- **In addition,** you can simulate the future system size of your system. This is useful for a forecast of the impact any planned measures may cause.

Beside the DVM Work Center, Data Volume Management offers services to give you an overview of your data distribution and quality as well as services to help you to develop a DVM road map for your system landscape. All services allow you to make flexible decision about your content and data volume management.

### Additional Information

For more information, see the SAP Help Portal at http://help.sap.com/solutionmanager.

## 3.5 Maintenance Planner

### Overview

You have to use the Maintenance Planner to do the conversion to SAP S/4HANA 1709. The Maintenance Planner generates the download files (add-ons, packages, DBDs, and the stack configuration file) that the Software Update Manager (SUM) uses to do the conversion. In particular, the Maintenance Planner checks if the following items are supported for the conversion:

- Add-ons to your system
- Active business functions in your system
- Industry solutions

If there is no valid conversion path for any of the items listed above (for example, an add-on is not released for the conversion yet), the Maintenance Planner prevents the conversion. After the check, the Maintenance Planner creates the stack configuration file (stack.xml).

**Note**

In order to generate the stack.xml, you need to have an SAP S/4HANA license. You can do the above checks without a license, but you cannot create a stack.xml with the Maintenance Planner without a license.


For preparatory steps specific to the conversion to SAP S/4HANA, see also Prepare the Use of the Maintenance Planner [page 23].

### Business Functions

Business functions can have the following status: `always_on`, `customer_switchable`, and `always_off`. This results in the following behavior during the conversion:

- If a business function was switched on in the start release system, but defined as `always_off` in the SAP S/4HANA target release, then a system conversion is not possible with this release.
- If a business function was switched off in the start release system, but defined as `always_on` in the SAP S/4HANA target release, then the business function will be activated during the conversion.
- If a business function is defined as `customer_switchable` in the SAP S/4HANA target release, it will keep the state defined in the target release during the conversion.

For more information about always-off and always-on business functions in SAP S/4HANA 1709, see SAP Notes [2240359](http://help.sap.com/sapn2240359) and [2240360](http://help.sap.com/sapn2240360).
Add-Ons

During the conversion, add-ons are either merged into SAP S/4HANA or deleted if no successor is available. Some add-ons may be included without being fully functional.

For a list of supported add-ons, see SAP Note 2214409.

For information about uninstalling add-ons, see SAP Note 2011192.

Industry Solutions

For information about supported industry solutions, see SAP Note 2491467.

3.6  Simplification Item-Check

With SAP S/4HANA 1709 the Simplification Item-Check (SI-Check) replaces the pre-checks available with earlier SAP S/4HANA releases. The SI-Check identifies all simplification items relevant for the current system. They will be called by the Software Update Manager (SUM) tool to ensure that the system is in a consistent state.

Note

For conversions with the target releases SAP S/4HANA 1511 and 1610 (all feature package stacks), the SUM still calls the old pre-checks which are delivered with SAP Note 2182725.

The SI-Check is delivered with SAP Notes 2399707 and 2502552. SAP Note 2399707 delivers the new check report; SAP Note 2502552 delivers the check classes via transport-based correction instructions (TCI) and prerequisite notes.

Implementing TCI and the SI-Check

1. To enable TCI implementation, follow the instructions provided in SAP Note 2187425 (see especially the PDF file attached to the SAP Note).

Note

If you do not enable your system to install TCI notes, SAP Note 2502552 will be implemented without the TCI part, which will cause missing check class errors.

2. Follow the process description in SAP Note 2502552 to implement the SI-Checks.
Running the SI-Check

You run the SI-Check to identify the simplification items relevant for your conversion project. We recommend to do this early in the project, to get an overview of the conversion scope.

1. Start the report `/SDF/RC_START_CHECK` in transaction SA38.
2. In the section `Simplification Item Check Options`, choose the target SAP S/4HANA version.
3. Choose the mode in which you want to run the checks:
   ○ In online mode: The results are displayed immediately after the check is finished.
   ○ As a background job: We recommend this option if the check will need a long running time.
4. Run the checks to get an overview over all simplification items and then check the system consistency with `Check Consistency for All`.
5. Check the results

The report returns a list of relevant and irrelevant simplification items. We recommend that you check every relevant simplification item for the impact it will have on your conversion project.

Some simplification items have a consistency check. The consistency check identifies inconsistencies in the system that would be a problem during the SUM process. It also provides additional information on how to solve the problem.

Some of the error messages from the consistency check aim for you to read and understand the information provided by the consistency check error – for example, the information might be about data loss incurred during the conversion process. These errors can only be processed by creating an exception for them which is logged in the system. The errors are highlighted in the report in the column `Exemption Possible`, so that you can see which errors need an exemption.

For more information about how to use the SI-Checks, see the user guide in SAP Note 2399707.

SI-Check Messages and Their Meanings

The SI-Checks checks your system for data consistency (necessary for the conversion of existing data) and effects on the data after the conversion. The severity of the resulting messages indicates whether there are no inconsistencies, warnings you should look at, or inconsistencies you need to resolve. The results are provided as green, yellow, or red messages:

Table 5: Message Overview

<table>
<thead>
<tr>
<th>Message Color</th>
<th>Message Return Code</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>0</td>
<td>These messages indicate that there are no technical or other inconsistencies. They also function as status messages and indicate that the conversion can go ahead.</td>
</tr>
<tr>
<td>Message Color</td>
<td>Message Return Code</td>
<td>Descriptions</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Yellow</td>
<td>4</td>
<td>These messages provide important information (or warnings) about various topics, such as changes to business functions, or adaptations that can be done either before or after the conversion (but must be done to ensure business continuity). They indicate that there are no technical problems for the conversion itself. However, some of these yellow messages provide information about possible data changes, changes in functionality, or required tasks after conversion. For instance, per default, no custom table appends are retained during the conversion – the data from those fields is just lost.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Caution</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Please do not underestimate yellow messages. Read them carefully and do what is required to ensure system consistency after the conversion, so that business continuity is not compromised.</td>
</tr>
<tr>
<td>Red</td>
<td>8 or 12</td>
<td>These messages always indicate inconsistencies in the system. These inconsistencies need to be solved before the conversion, as they would act as blockers in later SUM phases. Please read the messages for information about how you can solve the inconsistencies.</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>These messages show skippable errors that indicate important changes for the affected simplification items. The errors are no inconsistencies, but you need to confirm that you have read and understood them. Usually they point out imminent data loss, deprecation, or required activities after conversion. Once you have confirmed (that is, exempted) them, they will no longer act as blockers for the conversion.</td>
</tr>
</tbody>
</table>

### How to Perform Accounting Pre-Checks

Controlling and General Ledger pre-checks are included in the Simplification Item-Check but the pre-check program for Asset Accounting (FI-AA) is not included in this report. To run pre-checks for Asset Accounting you need to use the report `RASFIN_MIGR_PRECHECK` and implement the SAP Notes listed in the collective SAP Note 2333236. The report `RASPIN_MIGR_PRECHECK` needs to be run separately in each of your productive clients.

After you have technically converted your system to SAP S/4HANA, you have to migrate your migration-relevant Customizing settings as well as your General Ledger, Asset Accounting, Controlling and Material Ledger data to the new data structure.

For more information about the conversion of Financial Accounting, see SAP Note 2332030.

### Note

We recommend that you do the conversion to SAP S/4HANA in a development or test system first, so that you get access to the Accounting-relevant Customizing steps. You collect any changes in transport requests which you hand over to the SUM tool when you do your final conversion of your productive system.

For more information, see Conversion in a Distributed System Landscape [page 11].
3.7 Custom Code Analysis

The custom code migration checks are based on the simplification item concept. With SAP S/4HANA, business processes have been changed and simplified. Before converting to SAP S/4HANA, you need to check your custom code against the SAP S/4HANA simplifications in a SAP NetWeaver 7.52 system.

The simplifications are loaded into the Custom Code Migration tool. After you run the tool, you get a list of instances where your custom code does not comply with the scope and data structure of SAP S/4HANA.

**Note**
The custom code checks do not yet identify all the instances where your custom code does not comply with SAP S/4HANA. For a full overview of changes that may affect your custom code, see the *Simplification List*, as explained in *Overview of the Conversion Process*[page 7].

We highly recommend that you perform these checks before starting the conversion process, because this step is the most important preparation for your ABAP custom code on the way to SAP S/4HANA. Even if you do not plan to take development actions before the conversion, these checks will give you a sound foundation for your project planning and organization. They also enable you to decide on helpful preparatory activities, such as the decommissioning of unused custom code.

The application content of the simplification database is being increased and improved over time. In addition to the custom code analysis and adaptations based on the Custom Code Migration tool, you also need to test the custom code within SAP S/4HANA.

For additional information about the Custom Code Migration tool, see:

- SAP Note [2241080](http://help.sap.com/s4hana_op_1709) for information about how to download the simplification database.

3.8 Cross-Application Preparations

Before starting conversion activities, you need to do the preparatory activities described in the next sections.
3.8.1 Prepare the Use of the Maintenance Planner

Context

Besides the general preparation described in the *Maintenance Planner User Guide*, you have to make the following preparatory steps specific to the conversion to SAP S/4HANA 1709:

Procedure

2. Check the SPAM/SAINT version in your source release system.
   
   **Note**
   
   At least SPAM/SAINT patch 61 is required.

3. Apply SAP Note 2186164 to your SAP Solution Manager system.
4. Create an RFC-connection between your source release system and SAP Solution Manager:
   
   a. In SAP Solution Manager, choose **SOLMAN_WORKCENTER > Solution Manager Administration > Landscape (Technical Systems)**.
   b. Click **RFC connections > Start New Window**.
   c. Select client 000 and choose **Advanced Mode**.
   d. Under **Export Options**, fill in the field **SAP Solution Manager Host Name**.
   e. Under **Communication RFCs**, select **Create SM_<SID>CLNT<CLNT>_READ**.
   f. Select **Create New User**.
   g. Enter a password.
   h. Enter a user and password under **Managed System Setup Administrator**, and choose **Test Login** in the group **Administration Users** to check that it works.

Related Information

*Maintenance Planner* [page 18]
3.8.2 Remove Client 066

Context

Client 066 is the Early Watch client which was set up during the installation of your system. This client is not used in SAP S/4HANA. To prevent issues, for example, with job scheduling, you have to remove it before starting the conversion.

Procedure

To remove client 066, proceed as described in SAP Note 1749142.

3.8.3 Uninstall SAP Fiori Apps

Context

If you have SAP Fiori apps installed locally on your source system, you need to uninstall them if they are not released for USER INTERFACE TECHNOLOGY 7.50 (SAP_UI 7.50). If you do not uninstall these apps, the Maintenance Planer will not allow a conversion for your system.

Note

Use the SAP Fiori Apps Reference Library to check which applications are available for SAP S/4HANA 1709.

Procedure

1. Check SAP Note 2034588 for a list of apps that you need to uninstall and the steps required to do so.

   Note

   SAP Note 2200415 provides a list of all apps that are supported by SAP_UI 7.50.

2. Uninstall the apps using SAINT. For more information, see SAP Note 2011192.
3.8.4 Prepare the Conversion of Authorizations

Check the simplification items relevant for your conversion project for required transactions used by your existing business roles. After the technical conversion with the Software Update Manager tool, you need to adjust your business roles.

For more information, see Follow-On Activities for the Conversion of Authorizations [page 32].

3.8.5 Prepare the Conversion for SAP Fiori UX Enablement

The recommended access to functions in SAP S/4HANA is through SAP Fiori UX with SAP Fiori Launchpad that you run in a browser or in SAP Business Client. If you plan to follow this recommendation, you need to prepare the conversion of your existing authorization concept to support the role-based menu structure and authorization concept of SAP Fiori Launchpad.


One of the conversion goals is to keep your existing authorization concept as a basis for the converted authorization concept.

You need to review your authorization concept and map existing back-end role menu structures to SAP Fiori catalogs. SAP Fiori catalogs are assigned to front-end roles that define the SAP Fiori Launchpad content available to users. Use the SAP Fiori App Library to check the SAP Fiori catalogs or roles available for SAP S/4HANA 1709 applications.

We recommend to deploy SAP Fiori for SAP S/4HANA on its own front-end server in your system landscape. For more information, see http://help.sap.com/fiori_implementation [Installation and Upgrade] SAP Fiori: Getting Started SAP Fiori Deployment Options.

3.9 List of Application-Specific Preparations

The list below contains important application-specific preparatory steps and where to find their documentation.

**Note**

This list contains an overview of important steps, but it is not complete. You find the complete list of conversion-relevant items in the Simplification List, as explained in the overview [page 7].

<table>
<thead>
<tr>
<th>Table 6: App-Specific Preparations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preparatory Tasks per Application Area</strong></td>
</tr>
<tr>
<td>Enterprise Technology</td>
</tr>
</tbody>
</table>

Conversion Guide for SAP S/4HANA 1709
Preparing the Conversion
PUBLIC 25
<table>
<thead>
<tr>
<th>Preparatory Tasks per Application Area</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Life-Cycle Management: Check Program for Material Number Extension</td>
<td>SAP Note 2216958</td>
</tr>
<tr>
<td>Finance</td>
<td>Documentation of Finance-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>SAP Credit Management</td>
<td>Documentation of all SAP Credit-Management-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>SAP Cash Management</td>
<td>Cash management</td>
</tr>
<tr>
<td>Sales: Order and Contract Management</td>
<td>Foreign Trade Replaced by Global Trade Services</td>
</tr>
<tr>
<td></td>
<td>Revenue Recognition Replaced by SAP Revenue Accounting and Reporting</td>
</tr>
<tr>
<td></td>
<td>Simplified Data Models in Sales and Distribution (SD)</td>
</tr>
<tr>
<td></td>
<td>SD Pricing: Data Model Changes</td>
</tr>
<tr>
<td>Retail</td>
<td>Changes in Retail functionality</td>
</tr>
<tr>
<td>Supply Chain: Efficient Logistics and Order Fulfillment</td>
<td>Simplified Data Model in Inventory Management (MM-IM)</td>
</tr>
<tr>
<td>Environment Health and Safety</td>
<td>Documentation of all EHS-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>Product Safety and Stewardship</td>
<td>Documentation of all PSS-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>Discrete Industries &amp; Mill Products</td>
<td>Long material number</td>
</tr>
<tr>
<td>Business Network Integration</td>
<td>Conversion from Ariba Network Integration for SAP Business Suite</td>
</tr>
<tr>
<td>Media: Media Product Master</td>
<td>Documentation of all conversion tasks related to Media Product Master.</td>
</tr>
</tbody>
</table>
4 Realizing the Conversion

After the preparation phase, you start with the realization of the conversion to SAP S/4HANA 1709 using the Software Update Manager (SUM) tool. For a short overview of the entire process, see Overview of the Conversion Process [page 7].

After the SUM run, we highly recommend that you adapt your custom code, see Custom Code Adaptation [page 28].

**Note**

You find the cross-application follow-on steps in this guide; you get the application-specific follow-on steps with the Simplification Item-Check and custom-code checks and with the Simplification List for SAP S/4HANA 1709. Some of the most important application-specific preparation steps are also listed in this section: List of Application-Specific Follow-On Activities [page 35].

Please see also SAP Note 2495932.

4.1 Conversion Using SUM

Software Update Manager (SUM) is the technical tool used for the system conversion to SAP S/4HANA.

**Note**

You have to run the Maintenance Planner before the SUM, because the SUM requires the `stack.xml` generated by the Maintenance Planner as an input. For more information, see Maintenance Planner [page 18].
Within the SUM-process the following steps are done in a one-step procedure (for dedicated start releases):

1. Database migration (optional).
   If your source system is not yet running on the SAP HANA database, use the database migration option (DMO) of the Software Update Manager to migrate your database to SAP HANA during the conversion.
2. Installation of the SAP S/4HANA 1709 software.
3. Conversion of your data into the new data structure used by SAP S/4HANA 1709 (this is the automated part of the data migration).

For all information about using the SUM, see the guide System Conversion to SAP S/4HANA using SUM 2.0 <latest version> (incl. DMO) available at http://help.sap.com/sitoolset ➔ Software Logistics Toolset 1.0 (SL Toolset) ➔ System Maintenance ➔

4.2 Custom Code Adaptation

After the Software Update Manager (SUM) has done the technical conversion, you can start adapting your custom code.

1. You need to adapt any modifications and enhancements using the standard transactions SPDD, SPAU and SPAU_ENH.
   This is the same process as in previous upgrades in the SAP Business Suite product portfolio except that the tools SPDD and SPAU have been renewed.
2. You need to fix any issues due to SAP S/4HANA simplifications.
   To find the issues, you use the ABAP Test Cockpit (ATC) and do a check run with the check variant S4HANA_READINESS locally in your converted system.

We recommend to use the ABAP development tools for Eclipse to do the custom code adaptation as SE80 no longer supports all development object (such as CDS Views) needed in SAP S/4HANA. For more information about these tools, see the SAP Help Portal at http://help.sap.com/s4hana_op_1709 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ Application Server ➔ Application Server ABAP ➔ Application Development on AS ABAP ➔ ABAP Development Tools - Eclipse ➔

For more information about doing local ATC runs, see the SAP Help Portal at http://help.sap.com/s4hana_op_1709 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ Application Server ➔ Application Server ABAP ➔ Application Development on AS ABAP ➔ ABAP Development Tools - Eclipse ➔ SAP-ABAP Development User Guide ➔ Tasks ➔ Ensuring Quality of ABAP Code with ATC ➔ Working with ACT During Development ➔ Launching ATC Check Run from the ABAP Editor ➔

4.3 Cross-Application Follow-On Activities

After the Software Update Manager (SUM) has run, you need to do the follow-on activities described in the next section.
4.3.1 Adapting Database Extensions to SAP S/4HANA

Context

When you convert your system from SAP Suite on HANA to SAP S/4HANA 1709, modifications to the SAP HANA database remain unchanged. However, to make your modifications visible on the UI, manual steps can be required in different content layers.

Procedure

1. If required for your modifications, adapt the relevant Core Data Service (CDS) views in the SAP Business Suite layer. You can extend CDS views by using ABAP development tools. For more information, see http://help.sap.com/abapdocu_740/en/index.htm ABAP Keyword Documentation ABAP Dictionary ABAP CDS in ABAP Dictionary ABAP CDS - Views ABAP CDS - DDL Statements ABAP CDS - EXTEND VIEW

2. If required for your modifications, adapt the OData services for your CDS views in the SAP Gateway layer:
   ○ For OData services that are included in a CDS view definition as an annotation, the relevant artifacts are generated automatically. No modifications are required in the SAP Gateway layer. For more information, see http://help.sap.com/s4hana_op_1709 SAP NetWeaver for SAP S/4HANA Function-Oriented View Application Server Application Server ABAP Application Development on AS ABAP ABAP Development Tools - Eclipse SAP ABAP CDS Development User Guide Exposing CDS view as OData Service.
   ○ OData services that are not included in a CDS view definition must be redefined in Service Builder. For more information, see http://help.sap.com/s4hana_op_1709 SAP NetWeaver for SAP S/4HANA Function-Oriented View SAP Gateway Foundation (SAP_GWFND) SAP Gateway Foundation Developer Guide SAP Gateway Service Builder Data Modeling Basics Data Modeling Options Redefining Services.

3. If available for your app, you can use runtime adaptation to add, move, or remove view fields in the UI layer. For more information, see Adapting the User Interface [page 35]. As an alternative, you can extend views by using SAP UI5 extension points. For more information, see http://help.sap.com/s4hana_op_1709 SAP NetWeaver for SAP S/4HANA Function-Oriented View UI Technologies in SAP NetWeaver SAPUI5: UI Development Toolkit for HTML5 Extending Apps View Extension.

4.3.2 Output Management

SAP S/4HANA introduces a new style of output management. Note that other existing frameworks can be used as well, depending on the application.

You make settings for output control in Customizing under Cross-Application Components Output Control.
This is an overview of the required technical setup.

**Prerequisites for Output Control**

- bgRFC configuration has been set up
- Storage system and category have been maintained
- BRFplus is active and usable
- Adobe Document Services is available (when using Adobe Forms)

**bgRFC (Background Remote Function Call)**

Output control uses a bgRFC to process output. Therefore, you need to maintain the bgRFC configuration. Otherwise, no output can be performed.

You can perform all the relevant steps in transaction S BMPFC C ONF. One of the most important steps is defining a supervisor destination, as bgRFC doesn’t work without it.

For more information, enter the keyword bgRFC Configuration at http://help.sap.com, and refer to SAP Note 2309399 and SAP Note 1616303.

**Storage System and Category**

Output control needs a defined storage system (content repository) to save the rendered form output as PDF.

To set up the storage system, choose the following navigation option:

Table 7:

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>Transaction Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRO &gt; Cross-Application Components &gt; Document Management &gt; General Data &gt; Settings for Storage Systems &gt; Maintain Storage System</td>
<td>/nOAC0</td>
</tr>
</tbody>
</table>

You can set up the storage type which fits your needs, for example a SAP System Database, or a HTTP content server (such as fileserver, database, or external archive).

Once the storage system is available, you need to assign it to the predelivered storage category SOMU. To do so, choose the following navigation option:

Table 8:

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>Transaction Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRO &gt; Cross-Application Components &gt; Document Management &gt; General Data &gt; Settings for Storage Systems &gt; Maintain Storage Category</td>
<td>/nOA CT</td>
</tr>
</tbody>
</table>

Select category SOMU. For column Document Area, choose SOMU. For column Content Repository, choose the content repository you created in the previous step.

**Business Rule Framework plus (BRFplus)**
Output control uses BRFplus for the output parameter determination. Technically, BRFplus is based on Web Dynpro applications. Therefore, you need to set up the according ICF services:

Table 9:

<table>
<thead>
<tr>
<th>URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sap/bc/webdynpro/sap/fdt_wd_workbench</td>
<td>FDT Workbench</td>
</tr>
<tr>
<td>/sap/bc/webdynpro/sap/fdt_wd_object_manager</td>
<td>FDT Object Manager</td>
</tr>
<tr>
<td>/sap/bc/webdynpro/sap/fdt_wd_catalog_browser</td>
<td>FDT Catalog Browser</td>
</tr>
</tbody>
</table>

For more information, enter the keyword **Active Services in SICF** at [http://help.sap.com](http://help.sap.com). Once you've set up the services, download and install the required BRFplus applications from SAP Note [2248229](http://help.sap.com).

Procedure:

1. Access transaction BRF+.
   - If required, personalize your screen, and change the user mode from **Simple** to **Expert**.
2. On the **Business Rule Framework plus** screen, choose **Tools** ➔ **XML Import**.
3. On the **Business Rule Framework plus – XML Import** screen, under **File and Transport Request**, browse for the local *.xml files you want to import. You can import the files one after the other.
4. In the **Customizing Request** field, enter an applicable Customizing Request ID.
5. Choose **Upload XML File**.
6. Choose **Back to Workbench**.

**Adobe Document Services (ADS)**

Applications in SAP S/4HANA ship default form templates implemented as PDF-based print forms with fragments. They require ADS for rendering. ADS is available as cloud solution or on-premise solution.

The cloud solution is a service provided on the HANA Cloud Platform. See SAP Note [2219598](http://help.sap.com) for more information and links to the documentation for the new solution Form Service by Adobe.

For the on-premise solution, you need an AS Java installation (with **ADOBE usage type**) to run ADS.

ADS itself must have version 10.4 (1040.xxx) or higher. This version is delivered with SAP NetWeaver 7.3 EHP1 SP7 (and higher), NW 7.40 SP2 (and higher), and NW 7.50 (all SPs).

You do not necessarily need to use ADS, as output management also supports SAPscript and Smart Forms.

However, special customizing is necessary for these two form technologies, and restrictions apply. For more information, see SAP Notes [2292539](http://help.sap.com) and [2294198](http://help.sap.com).

**Printer Setup**

Printing is done using the spool. For more information, see the SAP **Printing Guide** at the SAP Help portal under [http://help.sap.com/s4hana_op_1709](http://help.sap.com/s4hana_op_1709) ➔ **SAP NetWeaver for SAP S/4HANA** ➔ **View All** ➔ **Function-Oriented View** ➔ **Solution Life Cycle Management**.

Output control uses the short name of the printer (for example LP01), as defined in transaction **SPAD**.

**Limitations**
● Printing using the spool is not available in release S4CORE 1.00 SP00. If this is the case, please upgrade to S4CORE 1.00 SP01.
● Currently, a PDF is always created for any kind of form. This has the following impact:
  ○ Previewing the document from the spool request is only possible when the device type is PDF1 or PDFUC.
  ○ Using another device type can lead to alignment issues for SAPscript and Smart Forms.
● Frontend output is not supported, since the output is processed via bgRFC.

Related Information

SAP Note 2228611

4.3.3 Follow-On Activities for the Conversion of Authorizations

You need to review your existing back-end PFCG role menus for obsolete transactions as well as for transaction code replacements. You can do this with the transaction SU25 report Exchange of obsolete transactions in role menu. For more information, see SAP Note 2465353.

If you plan to enable SAP Fiori UX, see Follow-On Activities for SAP Fiori UX Enablement (incl. Authorizations) [page 33].
4.3.4 Follow-On Activities for SAP Fiori UX Enablement (incl. Authorizations)

The following activities are relevant if you plan to enable SAP Fiori UX:

<table>
<thead>
<tr>
<th>Table 10: Activities for Enabling SAP Fiori UX</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activity</strong></td>
</tr>
<tr>
<td>Analyze SAP Fiori content with the help of the SAP Fiori Apps Library or with the SAP Readiness Check</td>
</tr>
<tr>
<td>Define your front-end catalogs for SAP Fiori</td>
</tr>
<tr>
<td>Activity</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>Define your front-end business role</td>
</tr>
<tr>
<td>Integrate SAP Fiori business catalogs into the back-end PFCG roles</td>
</tr>
<tr>
<td>Configure access to SAP Easy Access Menu and User Menu from SAP Fiori Launchpad</td>
</tr>
</tbody>
</table>
4.3.5 Adapting the User Interface

Use

Key users can adapt the user interface (UI) of their apps at runtime in a modification-free way, for example, by adding, removing, or moving fields and groups. Runtime adaptation is supported for apps that use SmartForm controls with stable IDs. Note that you can only add fields which have been made available for this app. If you need additional fields, you have to create them as described under Creating Custom Fields and Custom Business Logic.

More Information

For more information, see SAP Help Portal at http://help.sap.com/s4hana_op_1709  
SAP NetWeaver for SAP S/4HANA  
Function-Oriented View  
UI Technologies in SAP NetWeaver  
SAP Fiori Launchpad  
User Guide  
Using the Launchpad  
Adapting SAP Fiori UIs at Runtime.

4.4 List of Application-Specific Follow-On Activities

The list below contains important application-specific follow-on steps and where to find their documentation.

**Note**

This list contains an overview of important steps you may need to do after the conversion process, but it is not complete. You find the complete list of conversion-relevant items in the Simplification List, as explained in the overview [page 7].

<table>
<thead>
<tr>
<th>Follow-On Tasks per Application Area</th>
<th>Reference</th>
</tr>
</thead>
</table>
| Finance                                              | Documentation of Finance-related conversion tasks, see the SAP Note.  
SAP Note 2332030 |
| SAP Credit Management                                 | Documentation of all SAP Credit Management-related conversion tasks, see the SAP Note.  
SAP Note 2270544 |
| Human Resources                                      | Integration of HR Master Data  
SAP Note 2340095 |
| Sales: Order and Contract Management                 | SD Pricing: data model changes  
SAP Note 2267308 |
|                                                      | SD Rebate Processing replacement by Settlement Management  
SAP Note 2226380 |
<table>
<thead>
<tr>
<th>Follow-On Tasks per Application Area</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimization of SD Rebate Processing for Trade Promotion Management</td>
<td>SAP Note 2200691</td>
</tr>
<tr>
<td>Retail</td>
<td>Cleanup of Retail generic articles and variant data</td>
</tr>
<tr>
<td></td>
<td>Documentation of site master conversion, see the SAP Note.</td>
</tr>
<tr>
<td>Environment, Health, and Safety</td>
<td>Documentation of all EHS-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>Enterprise Portfolio and Project Management</td>
<td>Conversion tasks related to Commercial Project Management</td>
</tr>
<tr>
<td>Product Safety and Stewardship</td>
<td>Documentation of all PSS-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>Integration</td>
<td>Business network integration: Activities after converting Ariba Network Integration</td>
</tr>
<tr>
<td></td>
<td>Integration with SAP SuccessFactors Employee Central</td>
</tr>
<tr>
<td>Media: Media Product Master</td>
<td>Documentation of all conversion tasks related to Media Product Master.</td>
</tr>
</tbody>
</table>
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).